4.211J/11.016J (HASS-CI) Spring 2011
The Once and Future City MW 11:00-12:30
Professor Anne Whiston Spirn (spirn@mit.edu) Room 9-450B
http://architecture.mit.edu/class/city

THE ONCE AND FUTURE CITY

What is a city? What shapes it? How does its history influence future development? How do physical
form and institutions vary from city to city and how are these differences significant? How are cities
changing and what is their future? This course will explore these and other questions, with an emphasis
on twentieth-century American cities. A major focus will be on the physical form of cities — from
downtown and inner-city to suburb and edge city — and the processes that shape them.

Cities are constantly built and rebuilt; from the initial settlement to the present, successive layers leave
traces. There are also cities within cities; every city has many districts — downtown, neighborhoods,
suburbs, each evolving with its own history, institutions, successive populations, and urban form. The
result is a richly complex text of artifacts: from houses to schools and banks, playgrounds to parks and
plazas, alleys to boulevards, sewers to freeways. These provide clues to the environmental, social, and
political contexts in which they were built and to the people who built them, their needs and desires.
Armed with an understanding of places built in the past, we will turn to a reading of contemporary urban
settlements. What do the cities being built today reveal about the values societies and individuals hold or
reject?

We will explore these issues through lectures, readings, discussion, and analysis of particular places.
Boston will provide a primary text. A project involving short field assignments using historical maps and
photographs will provide further opportunity to use, develop, and refine new skills in reading the city.
The course takes advantage of opportunities afforded by the Web. The syllabus and a gallery of student
work are posted online. Students present their projects on their own homepage with links to the class
website (http://architecture.mit.edu/class/city). These student websites, along with readings and cases
presented in lectures, provide material for class discussion.

Work for the course is evaluated in three ways: a project consisting of four parts (60% of the final grade),
a weekly journal (20%), and class participation (20%). This is a HASS-CI class, which offers students
opportunity for verbal and graphic expression through class discussion, written texts, and website design.
Communication-intensive subjects in the Humanities, Arts, and Social Sciences require at least twenty
pages of writing divided among three to five assignments; at least one must be revised and resubmitted.

The class is limited to twenty-five students.
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http://architecture.mit.edu/class/city/syllabus.html

Class Schedule and Readings

All required readings are on reserve at the Rotch Library and are available at the MIT Coop. The

cities of Boston, Cambridge, and others in the region are also primary texts.

Readings are also available on S:2ll2r for those registered in the class.

I. Reading the City

Required Reading: Grady Clay, Close-Up: How to Read the American City
(Chicago, 1980)

February 2
February 7
February 9

February 14

February 16

February 22
[Tuesday]

How Can Cities Be Read and Why

The Once and Future City: Processes That Shape
Reading and Writing the City

Guides to Reading and Writing Boston

in ciass: Seleck a

Perspectives on Boston Sites

Workshop: Designing Your Website

II. City and Nature: Natural Processes as Agents of Change

Required Reading: Anne Whiston Spirn, The Granite Garden (Basic Books, 1984);
James Elkins, How to Use Your Eyes (Routledge, 2000): "Preface,"” "How to Look at
a Culvert," "How to Look at Pavement," "How to Look at a Twig."

February 23
February 25
February 28

March 2

March 7

The Granite Garden: Boston, A Natural Environment Transformed
Assignment #1 Due Online
Earth and Water

Air and Life

Boston Sites: What Patterns Emerged?

II1. City and Society: Social Processes as Agents of Change

Required Reading: Kenneth Jackson, Crabgrass Frontier: The Suburbanization of
the United States (Oxford, 1985); Sam Bass Warner, in Mapping Boston, edited
by Alex Krieger.
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The City Syllabus

March 9
March 14
March 16
March 19-27
March 28

March 30

http://architecture.mit.edw/class/city/syllabus.html

Looking at Maps

Technology, Innovation, and Change
Economics, Politics, and Change
SPRING VACATION

Culture, Fashion, and Change

Boston in Historical Context

Boston Sites: What Patterns Emerged?

IV. Looking Back, Looking Ahead: Envisioning and Shaping Future Cities

Required Reading: Jane Jacobs, The Death and Life of Great Amerlcan Cltles,

April 6

April 11
April 13
April 18

April 20

April 25

April 27

Splrn "The Yellowwood and the Forgotten Creek"; The West Philadelph

I website.
Looking Back, Looking Ahead?
Workshop: On Finding and Photographing Traces and Trends
Top-Down/Bottom-Up: Frameworks for Action
PATRIOTS DAY HOLIDAY

Workshop: Writing, Editing, Revising

Shaping Future Cities

Boston Sites: What Patterns Emerged?

V. Boston Sites: How Have They Evolved, Where Are They Headed

Required Reading: 2011 Boston Sites

May 3
May 5

May 10

May 12

Presentation and Discussion of Sites
Presentation and Discussion of Sites
Presentation and Discussion of Sites

Presentation and Discussion of Sites

2/7/2011 9:16 PM
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Guide to Geographic Information for 4.211j11.016J - The Once and Future City, Anne Spirn
Presented b§ Daniel Sh;;;\rﬁ enior GIS Specialist, MIT Libraries

Written by Lisa Sweeney, updated by Daniel Sheehan.

2/14/2011

Geographic Information offered through the MIT Libraries:

Rotch Library Map Room Hours: The collection is available: M-F, 10 am- 5 pm. It is organized
geographically — Boston Citywide maps; Boston neighborhoods (example: ‘central’)
Hayden Library Map Room — contains USGS topographic series in paper for entire United States;
accessible anytime Hayden is open
Barton:
o To limit your searches — use the advanced search option to limit search to formats/types
= Maps and enter the location of interest as a subject term
o To expand searches think about broadening geographically, for example: Dudley Square
-> Boston -> Massachusetts. Sometimes maps and datasets that cover a larger
geographic area will contain information of interest to a more specific location. Using
keyword searches generally returns more results than subject search
o Books can contain maps too (but may not be classified as format=map in Barton):
=  Mapping Boston: http://library.mit.edu/item/000908840
e Subject: “Boston (Mass.) -- Maps.” leads to other related titles
= Mapping New York: http://library.mit.edu/item/001691836
= Mapping London: http://library.mit.edu/item/001691834
Libguide: http://libguides.mit.edu/gis
o Not all paper maps in the Rotch Library collection are cataloged. There is a working
inventory available as an excel file on this libguide.

o Sanborn Fire Insurance maps tab
= Sanborns are available in multiple formats: Paper, Electronic, and Microfilm
*  For this semester we have online access to MA and NY (typically just MA) — must
be on campus or use the VPN
= Use the index to figure out which sheet your area of interest is on
o Information and links to local map repositories (Harvard, BPL, etc) and links to major
online map collections.
= Social Explorer — US Census data from 1790- present, as maps and tables
= David Rumsey collection - http://www.davidrumsey.com/ offers different ways
of viewing the collection (click “view collection” for 2D, 3D, Google Earth, etc);
the Boston, MA collection:

http://www.davidrumsey.com/luna/serviet/view/search/where/Boston+{Mass.)
/?q=boston&sort=Pub List No_InitialSort,Pub Date,Pub List No,Series No

=  Perry-Castafieda Library Map Collection: Navigate to US -> MA -> Historical City
Maps: http://www.lib.utexas.edu/maps/massachusetts.html

= American Memory: Cities and Towns -> Geographic Location Index->
Massachusetts — Needham Heights: http://memory.loc.gov/cgi-




bin/query/S?ammem/gmd: @FILREQ(@field(SUBJ+@od1(United+States--
Massachusetts--Boston+))+@FIELD(COLLID+citymap))

= New York Public Library — Picturing America, 1497-1899: Prints, Maps, and
Drawings bearing on the New World Discoveries and on the Development of the
Territory that is now the United States:
http://digitalgallery.nypl.org/nypldigital/explore/dgexplore.cfm?col id=190

=  Boston Atlas — “Future Boston Map Collection” contains historical maps

DOME:

o Atlas of the City of Boston, GW Bromley & Co., 1883-1885:
http://dome.mit.edu/handle/1721.3/47999 (and in Barton
http://library.mit.edu/item/000614122)

o Visual Collections —Aerial Photography: search for boston

MIT GIS Services: http://libraries.mit.edu/gis/
o Walk-in assistance hours: 12:30- 4 pm M-Th
Offers help with mapping demographics (census data)

Georeferencing — bringing a map image into a GIS
Geolytics — for mapping change over time with GIS (1970-2000)
MIT Geodata Repository —data for boston including parcel data with land use types
(2000-2008) http://libraries.mit.edu/gis/data/index.html
= Search for paper maps in the MIT Library

O O O ©O

= Search for scanned and georeferenced paper maps in the Harvard Geospatial
Library
o Email the team at gishelp@mit.edu
GPS units — available for checkout from Rotch Library front desk
o http://libraries.mit.edu/gis/software/gps.html
o 1dayloan - just need MIT ID card

o Longer than a 1 day loan email gishelp@mit.edu with request — requested loan period
and brief description of project.

o Can easily save collected data to GIS software, or google earth using free DNR Garmin
tool.

Questions?: email mapshelp@mit.edu

o Emails should contain a brief description of where (location of interest), when (what
years should the information represent), and what (types of information being sought -
buildings, elevations, land use?)




®e”ff\ 2illow 1

~ e 401 et nok qcadenic

m‘m‘[ §d450m Maps ON fU’iDef
Hod o Od whdt b alile

@(‘M& sy
@L{ g :/\ BPL
SWM% L‘Lé b nie maps

Sod GTS clhae i1 lub

Add SHroet otk

LOD[L far mﬁa@fq

CML N\@JF%(LO}Q Jrg 500 @Ahgr//@%ﬂ@ @me%o{/ puf’/'lﬂj{_

Can f)M mants B on Jop of Geile maps
ﬂgo;,\/@‘ﬂ {fm MY
A

“lass IS¢
= Hama{

"~ Pape A
M §[W g/
Hatvad - aJrud7 qu refieed
bt aed b €lgre ot projection
M g pdb(z(/



g
Buston P |
P TjPQ - W

View mdedele
ﬁumﬂ/] "\@Jrs of Lleﬁblt{
Lebtial cdeton. 9L

, —Ohine
\Wf&yg Cife goure

o s it G

69&5@1 Cogh 0 (jwwelg
USCS ‘J(opa,@fuph't(,
“Ou, 0 of Horvard

'Am O v Ky o2 e app
" o, )

St chw% rqpid)
Tl ot o

Posk
//0(@5 beealt 'n [
4 Wl:;ol/rv’mﬁ JO{O(,L\j

dattro h 1 Amﬁ/\@f

o f

md e frlog



Y
ij\w% \Déom ]9505
ot of gk ising
= hal W o eopond 10
"l n ol \D\Dob‘s
“OHQ’ \V)Vbll“@¥\1pe)



Cloe U
S o

0L
B?ﬂu\mg oy on eetlands
Yk oot ST,

pof\ laf\d “(,({{7 of YM\AQ ﬁom Oﬂer fla(es
AQ‘J(N T
i m[oh‘m@ Jn\fm \/() 9 0;)‘/{5%
QM& oA 6(@//@
= Glums
T Ao dnvv/\

Otaaghes
- of (dw mfv/'ub(s
- ey pl
N0 9ﬂad d(rspasa[ §g5)‘e/n
= lve calor

T 0 don bo al

rtﬂu‘(s
@oo&s MO fan,

Jﬂmggm«/s f‘XWQWMJ' 2 Ve fﬂm L\eav? (m(]/ﬁfz



@éﬂg
s otff o gy
waste
(it 60 Sl
Cfedfj (/ndefﬁfomd < 1/’105‘”7 7%
Ut b rorudl|

Valeys o e pr

hifes don hig af
“’\{m/t(%ﬂo’@

d‘a"qf names

ﬂ({dﬁ nay Mk o((gssqble cujkefn

{f@xﬂ (artles /\aﬂdeﬁnj (J‘\ ﬂt }Oas{/
M ohts e gwd —dan dwdﬂf
Turf

/ [
—fe an oiady  (Clase

- f@m&om QCE;’?\S 0(‘ (eg. '
Y/
B /fﬁ;ﬁﬂﬁm J /

~Clog off (ocal oteeets

(Deﬂlmb “p yos Nea \m ﬁ-b Oj(,rPo/ }
vdDb am) (lan‘ 6\5%/15

‘ va\f 0, 6![\&3@



Pf‘lm)fﬂ gqﬁa [}Wa’l
Jo Cobdde

fuL(Zj 5t
Cary

Varhags
Sephbon of  Aakral rege
‘D( ‘zce 5&49 le
(uter Countrles CWV;’“’)
OH Ses g %fmgfo/m%

MAWQ"% Mg of 4 (,Laﬂm,jg

data MOIAs g
—Fheo has cmged J



4.2

\"-._____.

M Moy ot boston 1507

S Viy Mm}:ﬂﬁ
ol ¢ Macs ey
Shaw whee ob gte g
et pegle canl @4
Lok PO hae ol ndiwrter

\’\/ashfmﬁm sioet wes f, @mﬁ/g street
W B s b Ul L 107

il 8

Nlﬁbm

U Jedd  Gue
Al e of e oot



(omb, of 9[& Jeral&/?[ﬂ/)MWL
z:m [Or‘l(/L(

Rk hver - bt mw}@ b offie aren
@’13 [M( W4

C(/HV[(LI vae/si(‘/v

Tf&\&a o popv[aﬂoq

B ﬂ%ao(‘a/f & s w/ eﬁm'c gragps
Wag s % Comy),

i |
Ewa Zd NELWJ@

["Ml Cﬁﬂﬂecﬁi{ by T(f%z'#
&Dddﬁ ‘Nldwd oer ‘Hxﬂg
/ﬂ(H 9{ mm A0 [ﬁ(ddl(,lf Qﬂld

C%ﬁ/md;
,__[,}/}WF Cavmf({ g ﬂ{ W”a/m i %M ﬂnfaaé;
~ vl LI aﬁéfﬁmwff/,’
&0[9, obé histetc presevatig,
— dlufelaty
= (nfpmied

7 L Soluchi
ﬁﬂa%mm-@‘a Yo



&

Iﬂk” W vwater clories
\NLLQ} (W14 (h\k {“05‘}' (‘Mpg/i‘aﬂf‘ 6/1;1}}3(!/9 f)m(&Sj

e

ij, sfe ea (370 map
U%ﬁ (15 MFGAFW

Fopooyur®y

TUQ‘( )0 /\OItaéﬁap = L/@b /‘(L,thm‘,w LJM\JWW
= @Haw,d fo S)MP



4.2113/11.016] | The Once and Future City

Wordpress | Setting up your website + blog

1.

8.

Begin by navigating to http://11.016.scripts.mit.edu/www/
Scroll to the bottom of the page, and click "Register” under the "Meta” category.

Create your own account and site by entering a username (probably easiest to use your Athena
username, but you can choose something else if you prefer) and your MIT email.
Be sure that "Gimme a site!” is selected, then click "Next".

Enter a Site Name for your URL. Again, it may be simplest to keep this as your username, but you
may choose something else if you prefer. Note: this cannot be changed!

Enter a Site Title, such as the name of the place you have selected to study. (Ex: Beacon Hill). You
can change this part later if need. Click "Signup”.

Check your email for a notification from Wordpress or "the once and future city 2011". (This email
sometimes gets redirected to spam, so check your spam folder if you don't see an email within a
couple of minutes.) Follow directions in the email to activate your site, then login with your new
username and the password supplied in another email from “the once and future city 2011".

Once logged in, you should see the Dashboard, from which you can manage your site. The first thing
you should do is change your password to something you can remember.

From the Dashboard menu on the left side of the page go to Users > Your Profile. Scroll to the bottom
of the page, where there is a field for your New Password. Be sure to save your changes.

By default, all new sites within our "the once and future city 2011" network will follow the same
template, which should already have your basic pages and blog set up for you.
You can go through the options to edit your site's theme, settings, pages, options, widgets, etc, but
be sure that your website includes the following (clearly linked) pages:

a. Site Selection

b. Natural Processes

¢. Site Through Time

d. Traces and Trends

e. Journal
Please also be sure to include a link to the main 4.211/11.016 class page somewhere on your site.
(This should be automatically included in your site’s links during setup.)
http://architecture.mit.edu/class/city/

New blog/journal posts can be displayed on your home page or another page of your choosing. To
change where new posts appear, go to Settings > Reading from your Dashboard menu.

From here, you will see options for what the Front Page Displays. Select Static Page, then use the
drop-down menu to choose which pages will be used your Front Page (ex: Home) and Post Page (ex:
Journal). For clarity, send your posts to Journal; you may also use this as your Front Page if desired.

Replace the default placeholder pages/text with your own assignments!

SUGGESTION: Keep it simple. The design of your website should show off good content, not be
confusing or complicated—easy navigation is crucial. See websites from previous years for ideas.

REMINDER: Website is due online by Friday, Feb 25™. It should include your first assignment (site
selection) and your journals to date, as well as the pages described above.



Photoshop | Resizing your images for use online

1. File > Open (select the image you would like to resize)
2. Image > Image Size. Click the "Resample Image” option at the bottom of the popup window.

3. Inthe "Document Size” area, replace the default resolution with 72ppi. This should automatically
adjust the pixel dimensions of your image. Click OK.

4. File > Save As > save your resized image with a new name. (Ex: Image01_smalljpg)
Note: Always keep your original photos; save your resized/adjusted images with a new name.

Image format guidelines for the web:

Image Resolution: 72 ppi max

Pixel Dimensions: 900 pixels max width (600-800px wide is good)

Image formats: .jpg, .png, .gif, are best; keep the file size relatively small, <1MB.
Larger/higher resolution files will only make your webpage load slowly.

Athena Computers with Photoshop:
All studio/lab computers in Architecture and DUSP:
3-415
5-414
7-303
7-401, -402, -408
7-432
9-251
9-551,-554,-555,-556
10-485
Other Athena clusters/labs:
E-15 IEL (within ACT, requires special permission for access)
4-035
26-139 (see http://web.mit.edu/nmc for details and reserved times)

Alternative software:

Photoshop Elements (basic Photoshop tools/functionality)

GIMP: open source image editor, similar to Photoshop http://www.gimp.org/downloads/
Other open source alternatives are listed here: http://www.osalt.com/photoshop
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MIT STUDENT WRITING AND SPEAKING SELF-ASSESSMENT

The MIT Communication Requirement stemmed partly from alumni feedback. MIT alumni con_sistent!y report
that expertise in communication principles and practices—in other words, knowing:’, how to write and speak
clearly and compellingly in both formal and informal situations—is essential t.o their (.:areers after MIT. A .
majority of MIT alumni report that they wish they had dedicated more of their own time and effort to learning
how to argue effectively with evidence, how to write and speak with grace and style, and how to assess and
provide for the needs of their various audiences.

As an undergraduate now in a Cl subject, you have the opportunity to learn from their experiencg a_arjnd to take
charge of your own communication education, which begins by assessing your knowledge ar.\d abilities, and
then setting specific goals for the semester. As you move through the communication requirement, you can
keep adding new or more advanced goals, so that by the time you graduate, you will have learned how to
write and speak as a professional in your field.

1. Name Date
2. Youryear: Firstyear Sophomore Junior Senior Your Course:
3. Subject

4. Did you take the FEE?
YES
NO

If “YES,” please list any specific advice about your writing that you remember:

5. Is this the first Cl subject you have taken at MIT?
YES

NO If “NO,” please list the other Cl subject(s) you have taken:

CURRENT KNOWLEDGE ASSESSMENT: WRITING FOR DIFFERENT SITUATIONS AND PURPOSES

6. From the following statements, select all that are true for you.
___I have always enjoyed writing and seek opportunities to write for different purposes.

___| believe that writing helps me to develop stronger ideas and to explore complex issues in academic work.

___I have sufficient experience and knowledge about writing in this subject.

I have no strong feelings about writing, neither seeking nor avoiding it.

___Ifind writing to be easy in some subjects and harder in others.

___lgenerally understand the principles for academic writing, but want to learn more about writing in this subject.
___l'haven't given much thought to writing in different situations: | just the write the same way in each subject.
I have mostly avoided writing, and subjects that involve writing.

| often feel unclear about the principles and purposes for writing in this subject, or in most subjects.

Adapted from the Writer’s Personal Profile developed by Tracy Ann Robinson for the Oregon State University
Writing Intensive Curriculum Program. For more information about the tool and best practices for using it,
please visit http://wac.colostate.edu/atd/assessment/robinson burton.cfm.




Writing and Speaking Self-Assessment—Page 2

7. Which kinds of writing are you most comfortable producing? (select as many as you like)
___ Personal writing {personal essays; first-person, factual narratives; journals, etc.)
__ Essay exams
___ Creative writing (fiction, poetry, etc)
____Technical writing
___ Blogs
____Factual reports
____Labreports
__ Literary analysis
___Summaries or overviews of a reading or topic (literature reviews, annotated bibliographies, etc.)
___Longer, synthetic arguments drawing on many sources
____Proposals
8. What, specifically, do you consider strengths in your writing?
1; 7
2.
3.

CURRENT KNOWLEDGE ASSESSMENT: APPROACH TO DRAFTING AND REVISION

9.  For each of the following aspects of the academic writing process, mark whether you consider your knowledge
and abilities STRONG (S), WEAK (W), or NEUTRAL (N) in that area.

_____Choosing an appropriate and workable topic

__ Locating and evaluating sources

_____Analyzing sources in detail and deepening your own interpretations

____ Developing a focused, arguable thesis claim

____ Organizing the information and ideas, and structuring them in a logical sequence
______Generating the first draft of your paper

_____Writing the introduction and/or conclusion

___ sticking to the topic; identifying and omitting extraneous information

______Moving beyond the surface or the obvious claims to a more rigorous argument

____ Creating smooth, logical transitions between paragraphs and sections
__Incorporating and citing sources in your text

_____Revising your draft for logic, structure, and development after instructor, peer, and/or self review
______Editing your draft for syntax, clarity, and professional presentation

_____Using an appropriate tone, writing style, and level of complexity for your target audience

Establishing and maintaining a writing schedule that gives you enough time to produce your best paper



Writing and Speaking Self-Assessment—Page 3

10. Inyour academic studies (and/or other areas of your life), how often do you use informal writing as part of your
thinking/learning process?

ALWAYS FREQUENTLY OCCASIONALLY NEVER

11.  What kinds of informal writing activities have you found helpful for clarifying your thoughts and integrating new
information and concepts as you develop your ideas for a draft?

___Summarizing ideas from lectures or readings

___ Writing out your own reflections and responses to readings or lecture material
____Writing critical questions and exploratory answers about the material as you read
___ Writing definitions of key concepts in your own words

___Keeping a general journal for recording thoughts and ideas

___Free writing on the topic before you begin formal writing

___Brainstorming notes in an informal outline, mind map, or cluster diagram
____Writing a formal outline

___Talking out your questions and ideas with a classmate or friend

12,  Briefly describe your typical approach to writing a first draft {_what do you do? How long do you spend on it?)

13.  Briefly describe your typical approach to revising drafts of your writing.

14.  What kind(s) of feedback from peers or instructors do you find most useful?
____Comments on my use of evidence and understanding of the content
___Comments on my thesis, original ideas, and insights about the material
___Questions that ask me to clarify what | mean in specific passages
___Questions that raise issues | hadn't yet considered, or considered fully
____Comments about the form or structure of my essay
___ Positive comments about what's working well
___ Critiques of what's not clear, accurate, or well-developed
___Specific sugge;;tions for further development

___ Editing marks on my syntax, grammar, and punctuation



Writing and Speaking Self-Assessment—Page 4

CURRENT KNOWLEDGE ASSESSMENT: SPEAKING ABILITIES AND RHETORICAL KNOWLEDGE

15.  With which of the following academic speaking forms do you feel comfortable:
___Speaking actively and often in full-class discussion
____Raising questions about materials or ideas in class
___ Speaking collaboratively in small groups to negotiate ideas and solve problems
___Debating informally in class discussion when there are differences in interpretation
___Debating formally with assigned or chosen positions
____Presenting informally on a reading or topic
____Presenting formally on your researth

____Providing feedback to other students on papers or presentations

16. From the following statements, select all that are true for you.
___ | have always enjoyed speaking in public and seek opportunities for public speaking.
___ | believe that articulating my ideas helps me to develop stronger ideas and to explore complex issues.
___ | have sufficient experience and knowledge about formal speaking in this subject.
___When | speak, | consider my audience and purpose.
___lhave no strong feelings about speaking, neither seeking nor avoiding it.
| speak primarily to communicate ideas that | already understand.
____lsaywhat I think, whatever the audience.
___I have never given formal speaking much thought.
____ I have mostly avoided public speaking, and don't find it easy.

___loften feel unclear about the principles and purposes for public speaking in this subject, or in most subjects.

SETTING PERSONAL WRITING AND SPEAKING GOALS FOR YOUR CI SUBJECT

Think about the kinds of writing and speaking you expect to do as a professional after graduation. Next, think about any
gaps that exist between your current repertoire of writing and speaking skills and those needed by professionals in your
field. To close these gaps, what needs to change about your writing and speaking?

The goals you choose should be rhetorically based, specific, and realistic (i.e., achievable). Thus, goals such as "ace this
course" (not rhetoric-based), "get better at writing" (too general), and "produce grammatically flawless first drafts"
{probably not realistic) are inappropriate for this exercise. List your goals here:

Writing:
1,

Speaking:
1.
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Assignment 2 http://architecture.mit.edw/class/city/assign2.html?Horde=e52 186¢5e...

ASSIGNMENT 2. YOUR SITE AND NATURAL PROCESSES

This is the second part of a four-part, semester-long project. The first part consisted of finding a
site. Now the task is to find evidence on your site of its environmental history and ongoing natural
processes. The objective, through the examination of your site and its context, is to explore how
natural processes shape cities.

Lecture notes and required readings will be helpful in identifying and thinking about how natural
processes have shaped and continue to shape your site; by now, you should have read Close-Up:
How to Read the American City and should finish reading The Granite Garden.

Start your investigation by locating your site on early maps of Boston, such as those shown in
lectures (several of these are depicted in John Reps, The Making of Urban America; many can be
found in other books, such as Alex Krieger, Mapping Boston). Do these maps depict any natural
features on your site itself? These may include rivers or streams, ponds, hills and valleys. If so, did
these features (or the absence of them) influence the settlement of your site? Examine your site's
location in relation to the natural features of Boston as a whole. Do you think this context
influenced the development of your site?

Take a walk through your site looking for signs of its pre-urban landscape: topography, for
example, or water features. Look also for signs of ongoing natural processes of air, earth, water,
and life (for example, light and wind; water flow and erosion; plant growth and animal
movements). How do these relate to some of the larger environmental issues discussed in lectures
and The Granite Garden? Make a map of your site with field notes of your observations.

Describe what you have found. The paper should be about 2400 words (approximately eight pages,
typed double-spaced), accompanied by illustrations. Look for patterns. Include a copy of the map
you used to discuss the environmental context of your site (don't forget to identify your site and to
list the source of the map!).

Successful papers are well organized, cite specific examples to make each point, put examples in
context, and are illustrated. In organizing your paper, focus on the features you found and the
broader issues they raise. Go beyond mere description. Choose your examples carefully and discuss
their significance.

Assignment #2 Due: Friday, March 4, 5PM. Post the assignment on your home page, send the
address to spirn@mit.edy, and send J2anne Wildman, the writing tutor, the address and a copy of
your text. Late submissions will receive a reduction in grade. There will be no extensions without
prior, written, consent of the instructor.

1 of 1 2/23/2011 6:48 PM
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4.211/11.016 ASSIGNMENT 1: SELECT A SITE

Basic Requirements
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Site Selection

Michael Plasmeier

After looking at a few other sections of Boston, | have settled on roughly 5 blocks in the South End
neighborhood. The area that | have selected is bounded by Huntington Avenue to the north, Harcourt
and W. Canton streets to the west, Columbus Avenue to the south, and Dartmouth Street to the east.
The defining feature of my siteis the massive Copley Place development. However, to contrast the scale
of Copley Place, | have also included a few blocks to the south of the complex. The blocks are comprised
of a mix of original “brownstone”-style homes, 70s-era church-sponsored low-income housing,” and a

groundbreaking late-80s mixed-income housing development called “Tent City.”?

By combining offices, retail, hotels, and restaurants in one facility, and linking it by sky-bridge to other o ‘s
g

tall office buildings, the developers of Copley Place sought to create their own Epitome District within - /
J(Q(M,f\ef/,w

their development.” In particular they sought to capture the “Political Venturi” who could eat, sleep, (;\;W(

WY

work, and shop all in the same development. The development is built around a mall which starts at the M“\\l\dp
o : . “’?e&wp\ﬂ :

west-most corner of my site with a bridge to the Prudential Center and stretches to the MBTA and W

Amtrak Back Bay station. Office buildings are built on top of the mall creating a large atrium in the

middle of the mall. The mall has two anchor stores which do not have anything built on top of them.

Two hotels surround the mall. One is attached to the mall, while the other sits on a narrow triangle of

land between Stuart Street and Huntington Avenue. In 2008, the owners of Copley Place proposed

building a residential tower over Neiman Marcus on Dartmouth Street. Those plans appear to have

been abandoned.

'College Rentals.“Methunion Manor Cooperative.” 16 Feb 2011 <http ://collegerentals.com/Methunion-Manor-
Cooperative—apartments-Boston—Massachusetts/>.

*Mass Movements. “Tent City in Boston.” 16 Feb 2011 <http://massmoments.org/moment.cfm?mid=126>.
*Clay, Grady.Close Up: How to Read the American City.New York; Praeger, 1973.




The mixed scale is very interesting, especially in the Boston area. One minute one is walking along a
tree-lined small street and then all of sudden one comes across what looks like a suburban office
building. As one rounds the corner, one sees a 40+ story hotel tower. Despite the large difference in
height, the effect is very gradual. In addition, | think that the developers built faux-brownstone
residential units along the edge of the site to temper the change of scale. | want to investigate this

further. Are these just facades or were they built separately?

The difference in income levels is also intriguing. One end of my site has a high-end hotel bordering
Copley Square, while 800 feet down Dartmouth Street sits one of the countries’ first mixed-income
developments. In 1968, the Boston Redevelopment Authority tore down the houses near the corner of
Dartmouth and Columbus streets without relocating the residents.® In protest, between 100-300
activists set up camp in tents on the site. Almost 20 years later an alliance of nonprofits and

governments built a “multi-racial, multi-ethnic” housing community on the site.

Underground transit corridors also define much of my area. The area that is now Copley Place was once
a rail yard for the Boston and Albany Railroad. In the early 1960s, the state of Massachusetts removed
much of the railroad and replaced it with the Massachusetts Turnpike.” As they were building the
highway, the state wanted to sell or lease out the rest of the land at the border of the Back Bay and
South End of Boston.® The Prudential Center complex was the first to be completed, with a tall tower
built on the land next to the expressway and a plaza was built over the expressway to make it disappear
underground. Copley Place was built almost 20 years later, around 1984, further covering the

expressway in a similar pattern to the Prudential Center.

“Mass Movements.“Tent City in Boston.” Mass Movements.16 Feb 2011
<http://massmoments.org/moment.cfm?mid=126>.

*Boston Roads.“Massachusetts Turnpike.”Boston Roads.16 Feb 2011 <http://www.bostonroads.com/roads/mass-
pike/>.

®Wikipedia contributors."Massachusetts Turnpike." Wikipedia, The Free Encyclopedia. Wikipedia, The Free
Encyclopedia, 15 Feb. 2011. Web. 16 Feb. 2011.



The Southwest Corridor also cuts through the site. In the late 1940s, William F. Callahan,Massachusetts
Public Works director, identified the route as a potential highway. The right of way was cleared in
anticipation of the highway project, leaving a long scar through the neighborhood.*However by the
1970s, urban highway construction had fallen out of fashion and the plan was dropped. However, the
route was reused as a new route for the Orange Line and Amtrak’s Northeast Corridor. The tracks from
Massachusetts Avenue east have been covered and the surface now carries a linear park. Today bikers

and pedestrians meander down the path. One can still see how old brownstones were knocked down to )
; ‘ S Wi e 15 a bt aboupt
create a path for the highway. Conclusionh 7, (6"([“'5 uie 5@@00(" H,ES
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"Wikipedia contributors."Southwest Corridor (Boston)."Wikipedia, The Free Encyclopedia. Wikipedia, The Free
Encyclopedia, 30 Sep. 2010. Web. 16 Feb. 2011.

Robin. “Boston's Open Spaces: The Southwest Corridor Park.” 19 Feb. 2010. Wicked Bostoner.16 Feb. 2011
<htt'p://wickedbostoner.blogspot.com/2010/02/b05t0ns-open-spaces—southwest-corridor.html>.



Produced in Google Earth, Google.



Produced on Bing Maps, Microsoft.



